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INTRODUCTION

CLASSIC VERB has been modelled after a world renowned studio reverb to achieve

its distinctive rich and textured classic reverb sound. CLASSIC VERB's algorithm
follows a completely different design philosophy and is unlike any reverb TC Works has
done in the past, offering a completely different sound from MegaReverb. Apart from
the elegant user interface, CLASSIC VERB features a choice of modulation types for
sonically rich timbres. Fifteen room types provide a wealth of different unique spaces,
featuring Halls, Plates, Cathedral, Spring as well as three rooms tuned especially for
vocal processing.

2 instances of the Plug-In require only one single DSP to run, allowing a total of up to
8 CLASSIC VERBs on a single POWERCORE - still leaving room for some other
Plug-Ins like EQs and Compressor Limiters. And of course, 24/96 is supported.

Enjoy!
The TC WORKS Team

ATTENTION!

THIS IS A POWERCORE PLUG-IN AND REQUIRES POWERCORE TO BE INSTALLED
IN THE COMPUTER! THIS PLUG-IN WILL NOT RUN WITHOUT POWERCORE.

is a TC Group company.

ULTIMATE SOFTWARE MAGHINES

© By TC WORKS SofT & HarDwARE GMBH 2002. ALL PRODUCT AND COMPANY NAMES ARE TRADEMARKS OF THEIR RESPECTIVE OWNERS.
ALL SPECIFICATIONS SUBJECT TO CHANGE WITHOUT NOTICE. ALL RIGHTS RESERVED.



GETTING STARTED
SYSTEM REQUIREMENTS

Windows

e POWERCORE running system 1.6 or later

e Windows 98SE, ME, 2000 or XP

e PIIl 500 or faster

¢ 128 MB RAM

e VST compatible Host Application

e System must meet requirements of the Host Application

Mac 0S

e POWERCORE running system 1.6 or later

e MacOS 9.04 or higher (Mac OS X when available)

® G3/300 or faster

e 128 MB RAM

e VST or MAS compatible Host Application

e System must meet requirements of the Host Application

GENERAL
GLOBAL CONTROLS

e To enter a numeric value in any CLASSIC VERB control, double-click on a
parameter’s value field and a pop-up field for numeric entry will appear. Confirm the
edited value by pressing <ENTER> or cancel the input by pressing <ESC>.

e To reset a control to its default value, press <ALT> and click on the desired control.

e <SHIFT> + clicking a control will behave as a fine tune adjustment.

A/B

The "A / B” function of CLASSIC VERB allow for a quick comparison of two different
settings. Select "Store” and then "A” or "B” to save a setting into either the "A” or

"B” memory. After setting up both an "A” and a "B” setting, you can simply select

either "A” or "B” to immediately compare the two settings.

As these are meant for a quick comparison, these settings are LOST when closing the
Plug-In! If you love your preset, we advise you to save it!
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. Reverb Controls

. Modulation Controls

. Active Modulation Display

. Input / Output Gain and Meter

. Wet (effected) / Dry (source) Mix
. Highcut Filter

. Color

. Preset Manager
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CLASSIC VERB
REVERB CONTROLS

The Reverb Designer is an interactive control for your Initial Reflections and Reverb
Decay. You can click on the arrows to freely adjust the gain of these parameters.
These parameters are also available in more traditional control dialogues.

2. Decay Gain (dB)

3. Delay Time (0-200 MS)

DELAY QE7 M5 & | DECA TIME 4.8 SEC 4. Reverb Decay Time

Y

©  ®

Note: Unlike MegaReverb, there is no independent control for the delay time for the
Initial Reflections and Reverb Decay.

1. Initial Reflection Pre-Gain

The Reverb Controls can be edited by double clicking into the field and typing the data,
or you can use the arrows to scroll parameter values.
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REVERB TYPE

Reverb Type is one of the more important parameters of CLASSIC VERB. By changing
the Reverb Type, you will completely change the characteristic sound of the reverb.
This will effect such parameters as the Initial Reflections, the Reverb Types, and the
Modulation available.

01 Classic Hall 06 Drum Room 11 Plate I*

02 Vocal Studio 07 Cathedral 12 Plate Il

03 Vocal Room 08 Ambience 13 Club

04 Vocal Hall* 09 Live Reverb 14 Living Room
05 Drum Box 10 Spring 15 Living Room

Note: Room types marked with an asterisk (*) do not have pre-gain! When a room type
without a pre-gain is selected, the pre-gain control will disappear.

PRE GAIN
The Pre-Gain control sets the level of the reverb’s Initial Reflections.

DECAY GAIN

The Decay gain control sets the level of the reverb’s decay. By minimizing the Decay
Gain and increasing the Pre-Gain to maximum, you can create the room impressions
without adding "mud” to the mix.

DELAY

The Delay control delays the starting point of the reverb’s Initial Reflections and decay.
This parameter can be used to change the sense of the size of the room, i.e. to make
the room larger, increase the Delay time so that the reverb’s decay starts later. The
maximum delay time allowed by the algorithm is 200 ms.

DECAY TIME

By grabbing the Decay Time controller, you can easily adjust the length of the reverbs
decay tail. Longer decay times make the space seem larger, while smaller decay times
will make a room sound smaller or boxier.
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MODULATION CONTROLS

MODULATION TYPE

Modulation adds a subtle and tasteful amount of animation to the reverb decay
creating very rich and sonically complex decays. In addition to being set to "off”, there
are 3 types of modulation for the decay of the reverb. The modulation types each have
different characteristics, and vary by the room type that is selected.

TYPE
0 I Il "
Off Wide Rich Deep

HOD TYFE o 1 WIDTH
o

$|'-'-' The Width parameter, indicated by “W”, controls the width
of the modulation. Double click to enter a parameter value or
scroll through the width range with the arrows.

DEPTH

The Depth parameter, indicated by “D”, controls the depth
of the modulation. Double click to enter a parameter value or
scroll through the depth range with the arrows.

ACTIVE MODULATION DISPLAY

The modulation display will show the width and depth of the modulation on the
reverbs decay. You can edit both the width and depth simultaneously in the display.

IN / OUT METERS

The meters monitor the Input and Output levels in dB and feature a
Peak Hold option. The CLIP leds will turn red if signal ever reaches 0dB
or greater.
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METERING OPTIONS

Our Peak Hold metering is designed to track and hold the peak signals for about 2
seconds. You can move the cursor anywhere in the meter display and click-hold the
mouse button to reveal the Display options for Peak Hold.

ACTIVATE PEAK HOLD

Selecting this from the "Display” options will activate the Peak Hold.

DEACTIVATE PEAK HOLD
Selecting this from the "Display” options will deactivate the Peak Hold.

RESET PEAK HOLD
Selecting this from the "Display” options will reset the Peak Hold.

NIGHT VISION

Selecting this from the "Display” options will activate the "Night Vision” lamp, which
may be required for those late night mix sessions. ; -)

WET / DRY MIX

This parameter sets the balance between the source signal and the processed signal.
At 0%, you will only hear the source, while at 100% you will only hear the signal
processed with CLASSIC VERB. When you are using CLASSIC VERB in a send/return
configuration, you should set the Mix to 100% to bypass the dry signal.

6 / CLASSIC VERB



HIGH CUT FILTER

The input to CLASSIC VERB is processed with a low pass filter which allows you to roll
off the high frequencies of your reverb effect. In general, you will want to make your
reverb effect a bit darker than the source signal, as it might otherwise sound unnatural
or even unpleasant.

FREQUENCY

Sets the cut-off frequency for CLASSIC VERB's input filters. Use this to band-limit the
early reflection and decay characteristics of the effect.

GAIN

Defines how much the input to CLASSIC VERB is damped in the high-frequency area.
The scale of the filter is 6dB / octave.

COLOR

These parameters change overall tonal characteristic of your reverb preset. With some
simple adjustments, the "color” of your reverb can vary from bright and shining to dark
and mellow.

L0

The LO color controller affects the low frequency content of the processed signal.
By increasing the LO color parameter, you will hear a resulting increase in the low
frequency content of the reverb. By contrast, reducing the LO color parameter value
will result in a decrease in the low frequency content of the reverb.

HI

The HI color controller affects the high frequency content of the processed signal.

By increasing the HI color parameter, you will hear a resulting increase in the high
frequency content of the reverb. By contrast, reducing the HI color parameter value
will result in a decrease in the high frequency content of the reverb.

Note: If the High Cut filter is activated, boosting the HI color parameter may not have
an impact on the overall tonal characteristics of the sound.

Note: Typically, reverbs that are described as "cold” have a high frequency content that
is not normally present in most naturally occurring reverbs. To get a "warmer” or more
natural reverb, increase the LO color and decrease the high color parameter values.
Alternatively, you can use the Highcut filter to further reduce the high frequencies.
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PRESET MANAGER

CLASSIC VERB features a comprehensive file based preset architecture that makes
archiving presets a breeze. This allows you to organize your presets in a way you find
most comfortable for your workflow, and to exchange presets and curves with other
users, no matter what platform or application they are using.

Presets are saved as discrete files on your hard drive. Once a preset is saved into the
default location, it will automatically appear in the "File” menu every time you use the
Plug-In. The files can then be arranged in sub-folders, which will also be recognized by
the Plug-In.

FILE

Pressing the "File” button will open up the file menu. The following options are
available from the file menu.

LOAD PRESET

By selecting "Load”, you can navigate to any folder on the system, including any
"Shared” folder. By default, these will be loaded from the default location for
CLASSIC VERB presets.

Only presets located in the default file location will appear in CLASSIC VERB's pop-up
preset menu.

SAVE PRESET

By selecting "Save”, you can save your preset to any folder on the system, including
any shared folder. By default, these will be saved to the default location for
CLASSIC VERB presets.

Load Preset CLASSIC VERB can arrange presets into
save Preset different sub-folders. These subfolders
Booths b are sorted into basic reverb types such as
Effects > Rooms, Halls, etc.

Arena Empty You can delete, re-arrange or create your
Rooms P ArenaFull own folders to accommodate your needs.
Choirl Female Cool Hall You could, for example, create preset
Choir2 Female Warm Hall | {5|ders for projects, customers, or by genre.
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DEFAULT PRESET LOCATIONS:

The following locations will describe where you can find your CLASSIC VERB presets,
which are stored in different folders.

MacO0S Classic: files are stored in the System folder.
System Folder: Application Support : TCWorks : POWERCORE: CLASSIC VERB: Presets

MacO0S X: files are stored in your user folder.

Users: Your Name: Library: Application Support : TCWorks : POWERCORE :
CLASSIC VERB: Presets

Windows: files are stored on the Windows OS Hard Drive.

System Hard Drive:\Program Files\TCWorks\System\Application Support POWERCORE\
CLASSIC VERB \ Presets

® To delete a file, simply move the file to the "Trash” or "Recycle bin".
e To create a new sub-folder that appears in the Plug-In menu, simply create
one in the PRESETS sub-folder of the CLASSIC VERB default preset location.

ACCESS PRIVILEGES IN MACOS X

If you want to share your files with another user, it is advised to copy your presets to
the "Shared” folder before logging in as another user.

If you save files into the system folder, make sure that you have the appropriate
Administrator rights.

Preset sub-folders will not appear in the File Menu unless there is at least one file in
that subfolder.
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